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Abstract 

Customer and Service Tracking (CAST) is a database application for UPA Technology.  
UPA Technology is an coating thickness and measuring company, and since UPA Technology is 
in a highly technical field, off the shelf products have not fulfilled their needs.  UPA currently 
uses a 20 year old database application in combination with a newer off-the-shelf program.  
CAST solves their needs for a customer database, as well as giving the ability to track customer 
equipment and services.  CAST provides the ability to track customers and their equipment, 
upcoming calibration dates and service histories. 
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UPA Technology Customer and Service Tracking Database 
Application 

1. Statement of the Problem 

UPA Technology is a high-tech company that manufactures, repairs and resells coating 

thickness measuring equipment.  To function effectively, UPA Technology needs a database 

application capable of tracking customer information, contacts, equipment and equipment service 

records.   

Currently UPA Technology’s main database is a 20-year-old DOS-based database 

application.  This database application does not suit the company’s needs; it is old, cannot be 

enhanced and offers very limited functionality. UPA Technology recently, within the past year, 

purchased an off-the-shelf customer database application in an attempt to migrate from the DOS-

based application.  After using the off-the-shelf application for several months, the company is 

not satisfied.  Although the new application offers more features, many of them serve no purpose 

for UPA, making the application difficult to use because the extra features get in the way.  

2. Description of the Solution 

The UPA Customer and Service Tracking Database Application (CAST) allows 

employees to easily add, edit and track customers and service records.  In addition, the new 

application incorporates a centralized database allowing the information to be shared with all 

application users as changes are made, and the centralized database will also provide information 

redundancy. 

CAST’s purpose is to provide UPA employees with a simple, easy-to-use application that 

offers the functionality they want and need without unusable features getting in the way. Only 
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features that they need are included in the database application to prevent the interface from 

becoming cluttered with features that may confuse users. 

UPA needs the basic functionality of a customer database application.  The basic features 

of the customer database are to add/edit customers, add/edit/remove contacts for the customers, 

add/edit customer equipment and search for customers by name.  The application also offers the 

basic functionality of several different user levels with varying access to specific features.  

UPA needs to be able to track services for its customers’ equipment.  Because companies 

must comply with federal regulations, their equipment needs to be calibrated at certain intervals.  

UPA needs to be aware of upcoming calibration dates, so it can contact customers and schedule 

times to calibrate the equipment. CAST provides the ability to enter equipment calibration cycles 

and notify users of calibrations that are due within the next thirty days. 

UPA also needs to be able to find customers with specific equipment or in specific areas, 

so CAST includes a detailed search.  The application allows users to search for specifics in the 

address, area code, equipment (manufacturer or model) or the equipment type (UPA 

services/sells multiple types of equipment). 

2.1 User Profiles 

The intended user of this application will be the staff of UPA Technology.  A basic 

understanding of Windows and Windows-based applications will be required.  CAST will have 

two levels of access: administrators and users.  The different users will be provided with the 

same user interface, but administrator accounts will have the “Administration” menu, used to 

perform administrator functions.  Figure 1 (page 3) shows the functionality provided to each 

user. 
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Figure 1: User Diagram 

2.1.1 User 

 The user accounts will be used primarily by technicians and salesmen.  These accounts 

will have full access to all customers and equipment listings.  Users will have numerous abilities: 

search the database; add/edit customers; add/edit/remove customer contacts; add/edit equipment; 

commit repairs and calibrations; and view service history. 

2.1.2 Administrator 

The administrator accounts will be used primarily by UPA managers: people that have a 

good understanding of the company and its policies.  Administrators will be able to 

create/modify/delete user accounts and add/edit/delete equipment from the equipment databases.  

Only administrators will have this ability to ensure the database does not become cluttered with 
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repeat equipment and to maintain a certain naming standard so that search terms remain 

consistent.  In addition to the administrator functions, administrators will have all the 

functionality that users have. 

2.2 Design Protocol 

2.2.1 Color Scheme 

 The color scheme used throughout the application is the default Windows grey 

background, black lettering and white text boxes/list boxes.  This basic color scheme is desirable 

because it is easy on the eyes, which is very important since this application will be used for the 

majority of a work day. 

2.2.2 Navigation 

 Before accessing any program functionality, a user must first login.  Once the user is 

authenticated, the automatic reminders are displayed.  After the automatic reminders window is 

closed, the main customer information display is visible.  It is from here that all of the customer 

information is displayed and changed.  Figure 2 (page 5) shows the different navigation sections 

of the customer display. 
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Figure 2: Main Display 

 The functionality menus are where most of the program’s functionality is located.  From 

these menus, the user can print, perform advanced searches, add new customers, add/modify 

users or add/modify equipment.  This functionality is described in further detail in sections 5.4, 

5.5 and 5.4. 

 In the top right corner of the screen is the customer name search box.  This search box 

allows the user to quickly search for a company by the company’s name.  When the user enters 

text into the box and presses search, a search is performed for any company beginning with the 

text that was entered.  For example, if the user enters “mag” into the search box, the search will 
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return all names that begin with “mag” such as “Magna,” “Magnetic,” etc.  All results are 

displayed in the search results list box which is located directly below the functionality menus. 

 Below the search box are the customer information navigation tabs.  From these tabs, the 

user can edit customer information, such as edit customer contacts and equipment, submit 

calibration reports, submit repair reports or view calibration/repair history.  All customer 

information is changed through these tabs, which are described in further detail in section 5.3. 

2.2.3 Database Diagram 

 CAST will use six tables to store user information, customer information, customer 

equipment, customer contacts, all equipment and the service history.  The database being used is 

Microsoft SQL Server Workgroup 2005.  Figure 3 (page 7) shows the tables and how they are 

related. 
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Figure 3: Database Diagram 

3.  Deliverables 

General user functionality 

• Windows application to store customer information and track services completed for 
the customer 

• Logon that is authenticated by the database – when a user attempts to login, the login 
and password is checked against the database.  If the correct login and password are 
found, the customer display screen appears and the appropriate functionality is 
displayed depending on user type. 

• Add/Edit customers 
o Add/edit/remove contacts 
o Add/edit equipment 

• Track equipment calibration cycles 
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• Automatic reminders for calibrations – when a calibration date is near for a piece of 
equipment, an automatic reminder will be displayed when the user logs into the 
system.  This functionality will also be available through a menu option on the 
toolbar. 

• Advanced search capability based on specific customer or equipment information – 
this allows the user to search for more specific results based on criteria such as 
customer location, equipment type or specific equipment make/model. 

• View service history – allows the user to view all the previous services completed for 
a customer. 

 

Administrator additional functionality 

• All of the general user functionality listed above 
• Create/modify/delete users – allows the administrator to create or modify user 

accounts. 
• Add/modify equipment – allows the administrator to add equipment that can then be 

added to a customer or modify existing equipment. 
 

4. Design and Development 

4.1 Budget 

The majority of the work was completed on my home computer and the rest was 

completed at the College of Applied Science computer lab.  A removable flash drive was used to 

store and backup the code and database.  The database was stored on the senior server in the 

computer lab when working at the College of Applied Science.  The permanent database was 

stored on UPA Technology’s server.  Figure 4 (page 9) describes the cost necessary to complete 

this project. 
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Item Description Retail Cost My Cost 
1GB Flash Drive Have $59.99 $0.00 

Server Have 2,046.00 0.00 

Microsoft SQL Server 
Workgroup 2005 

Have 3,899.00 0.00 

Microsoft Visual Studio .Net 
2005 

Provided by IT lab 299.00 0.00 

 Retail Total: $6,898.99  

 My Total:  $0.00 
 

Figure 4: Budget 

4.2 Timeline 

Many tasks were needed for the completion of this project.  Figure 5 displays an 

organized timeline for the completion of the project.   

 

Figure 5: Timeline 

4.3 Resources 

Several hardware and software components were necessary in the development of this 

project. 
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• Hardware 

o Flash drive: Used to back up the code and database 

o Server: Where the database (Microsoft SQL Server) will be installed 

• Software 

o Microsoft SQL Server Workgroup 2005: Relational database used for the 

application 

o Microsoft Visual Studio .Net 2005: Development environment for C# code 

 

5. Proof of Design 

5.1 Login 

Each user must login with a user account that has been set up by an administrator.  The 

login window connects to the database and authenticates the user.  If the user login and password 

are correct, the user logs in and sees the main customer display.  If the user is an administrator, 

the “Administration” menu will be available; if he/she is a regular user, the “Administration” 

menu will not be visible.  Figure 6 (page 11) shows the login screen. 
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Figure 6: Login Screen 

5.2 Automatic Reminder 

 Once the user is logged in, the “Upcoming Calibrations” dialog is automatically 

displayed (see Figure 7. page 12).  The “Upcoming Calibrations” dialog lists all equipment, and 

the company that owns it, that will require calibrations within the next 30 days or with overdue 

calibrations. This list can be printed. When the “Print List” link is pressed, the list of upcoming 

calibrations will print.  The printout will include the company name, address, phone number, a 

list of all company contacts and the list of equipment, including the manufacturer, model, serial 

number and the next calibration date. 
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Figure 7: Upcoming Calibrations 

5.3 Main Display 

After the “Upcoming Calibrations” dialog is closed, the user will see the main customer 

information display (see Figure 8. Page 13).  From here the user can search for customers, add 

customers, edit customer information, add/edit/remove contacts or add/edit equipment.  From 

this display, the user can also view the service history of the customer, submit a repair report or 

submit a calibration report.  These options are available through tabs at the top of the customer 

information area. 
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Figure 8: Customer Display 

5.3.1 Customer Information Tab 

 The “Customer Information” tab displays all information about a customer, including that 

customer’s contacts and equipment, and allows the user to edit the information about the 

customer.  Figure 9 (page 14) shows what the tab looks like when a customer has been loaded. 
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Figure 9: Customer Information Tab 

5.3.1.1 Customer Information 

 The customer information that is displayed on this tab includes customer account type, 

account sponsor (if the account type is “In-house” or “Rep” the user can enter the sponsor for the 

account), shipping address, mailing address, phone number, fax number and notes.  All 

information about a customer can be changed by the user.  The phone number and fax number 

text boxes use a mask so that all numbers are entered in the same way in order to standardize the 

insertion of the phone numbers and allow for easier searching.  Once information for a customer 

has been changed the user is able to press the “Save Changes” button or the “Reset Changes” 

button.  If the user presses the “Reset Changes” button, the customer’s information is reset to 
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what it was when the customer was first loaded.  If the user presses the “Save Changes” button, 

as long as a company name is present, the user information is saved.  If more than one user is 

editing the same customer simultaneously, CAST will give a warning before overwriting 

changes. For example, if User 1 makes and saves changes to a customer, User 2 will not be 

allowed to save additional changes. Instead, User 2 will receive a warning stating that the 

customer has been changed since he/she loaded it, and the user is asked to reload the customer 

before saving.   

5.3.1.2 Contacts 

 All contacts that are added to a customer are unique to that customer.  A customer can 

have an unlimited number of contacts.  The contacts list is located above the notes section for the 

customer and displays all information about the contact that has been entered.  The contacts list 

scrolls both horizontally, in order to display all information about a contact, and vertically, to 

display all contacts for the customer. 

In order to add a customer, the user needs to press the “Add” button directly under the 

customer display box.  When the user presses the “Add” button, the “Add Contact” dialog is 

displayed (see Figure 10. Page 16). 
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Figure 10: Add Contact 

As figure 10 shows, the user can enter a first name, last name, phone number, extension, 

cell phone number, fax number, email or position for a contact.  The only information that is 

required is the contact’s first and last names.  Once the information has been entered for the 

contact, the user can either press the “Save” button or the “Close” button.  If the user presses the 

“Close” button, the dialog is closed without saving any information for the contact.  If the user 

presses the “Save” button, the contact is saved if the required information has been entered.  If 

the required information has not been entered, the user is warned that not all information has 

been entered, and the contact is not saved.  Once a contact has been saved, the dialog is cleared 

so that the user can continue to add more contacts if needed. 

 If the user wants to edit a contact for a customer he/she can either double click that 

contact in the list or select the contact and press the “Edit” button located directly under the 
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contact list.  The “Edit” button is not enabled unless a contact has been selected from the list.  

Figure 11 shows the “Edit Contact” dialog. 

 

Figure 11: Edit Contact 

When the user is done editing the information for the contact, he/she has the option to 

press the “OK” button or the “Cancel” button.  If the user presses the “Cancel” button, the 

information is not saved, if any changes have been made, and the user is returned to the customer 

display screen.  If the user presses the “OK” button, any changes that have been made are saved 

and the user is returned to the customer display screen.  Once either the “OK” button or the 

“Cancel” button have been pressed and the user is returned to the customer display screen, the 

contact list is updated to reflect any changes that have been made. 

 If the user wants to remove a contact, he/she must first select the contact from the 

contacts list and then press the “Remove” button located directly below the contacts list.  Once 
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the user has pressed the “Remove” button, he/she is asked if the contact should actually be 

removed, in case it was pressed on accident (see Figure 12). 

 

Figure 12: Remove Contact 

 If the user presses “No”, the confirmation dialog closes and the contact is not removed 

from the customer.  If the user presses “Yes”, the confirmation dialog closes and the contact is 

removed from the customer.  After the contact is removed from the customer, the contacts list is 

updated to reflect the change. 

5.3.1.3 Equipment 

 The equipment list displays all equipment for the customer by type.  The five types 

include x-rays, bench equipment, portable equipment, standards and other.  The equipment is 

listed in each section alphabetically by the equipment name (manufacturer + model).  The list 

displays the equipment name, serial number and the next calibration date.  If the calibration date 

is within 30 days, or is overdue, the next calibration date is displayed in red so that it is easy to 

find. 

 To add equipment to a customer the user must press the “Add” button located directly 

under the equipment list and the “Add Equipment” dialog will appear (see Figure 13. Page 19). 
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Figure 13: Add Equipment 

 To add equipment the user must first choose the equipment type from the equipment type 

drop down box.  The equipment types are the same as in the equipment list; x-rays, bench, 

portable, standards and other.  Once the equipment type has been selected the equipment list will 

be populated and the user can then choose the exact equipment he/she wants to add.  Once the 

equipment the user wants to add has been chosen, the user can enter the next calibration date.  

The user can either manually type in the next calibration date or can select the drop down arrow 

and select the calibration date from the calendar as shown in figure 14. 
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Figure 14: Add Equipment Calendar 

 The user can then enter the serial number for the equipment.  Once all the information 

has been entered, the user can press the “Save” button or the “Close” button.  If the user presses 

the “Close” button, the “Add Equipment” dialog closes. If any information had been entered, that 

information is not saved.  If the user presses the “Save” button, the equipment is saved if all the 

required information has been entered.  If the required information has not been entered, the user 

is warned that not all information has been entered and the equipment is not saved.  If the 

equipment was successfully saved, the dialog is reset so the use can add more equipment to the 

customer without having to continuously open the “Add Equipment” dialog. 

 If the user wants to edit existing equipment for a customer, he/she can either double click 

the equipment in the list or select the equipment and press the “Edit” button located directly 

under the equipment list.  As shown in figure 15, all information for a piece of equipment is 

editable except the equipment name. 
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Figure 15: Edit Equipment 

 When the user is done editing the equipment he/she can press the “OK” button or the 

“Cancel” button.  If the user presses the “Cancel” button, the dialog is closed and no changes are 

saved, if any were made.  If the user presses the “OK” button, the changes are saved and the 

dialog closes.  Once the dialog has closed, the equipment list is updated to reflect any changes 

that were made. 

5.3.2 Submit Calibration Report Tab 

 In order for the application to track calibration dates, the users must submit calibration 

reports after a piece of equipment has been calibrated.  This allows the application to calculate 

the next calibration date for the equipment, which in turn allows the application to display 

automatic reminders for upcoming calibration dates.  As figure 16 (page 22) shows, the “Submit 

Calibration Report” tab displays a list of all equipment owned by the displayed company in 

much the same way the “Customer Information” tab displays the list; the calibration date for 

equipment is displayed in red if the calibration date is within 30 days.  This allows the user to 
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quickly find the equipment that was calibrated since he/she will only be performing the 

calibration if the equipment is due within the next 30 days.  

 

Figure 16: Submit Calibration Report Tab 

 In order to submit a calibration report, the user must first select the equipment that was 

calibrated from the equipment list.  After the equipment has been selected in the list, the 

equipment’s information is loaded into the calibration report area to the right of the equipment 

list.  Next, the user enters the date the equipment was calibrated into the “Actual Calibration 

Date” date field.  The user then selects the technician that completed the calibration from the 

“Technician” drop down box, which is a list of all users of the application.  The user can then 

enter any calibration notes, if any.  Once the information has been loaded, the user can press 
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either the “Save Calibration” button or the “Cancel Calibration” button.  If the user presses the 

“Cancel Calibration” button, all fields are reset and no change is made to the equipment.  If the 

user presses the “Save Calibration” button, the calibration report is saved if all required 

information has been entered.  If not all required information has been entered, the user is 

warned that all required information has not been entered and the calibration report is not saved.  

When the calibration report is saved, the equipment’s next calibration date is then calculated.  

This change is immediately visible after a calibration report is saved, because all equipment lists 

for the customer are updated to reflect the change. 

5.3.3 Submit Repair Report Tab 

 Since UPA Technology also wants to track the repair histories for equipment, the users 

can submit repair reports in the “Submit Repair Reports” tab.  As Figure 17 (page 24) shows, this 

tab is set up much like the calibrations report tab; the equipment list is on the left displaying all 

equipment for the customer and on the right is the repair report area.    
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Figure 17: Submit Repair Report Tab 

To submit a repair report, the user must first select the equipment from the equipment 

list.  After the equipment has been selected in the list, the equipment’s information is loaded into 

the repair report area to the right of the equipment list.  Next, the user enters the date the 

equipment was repaired in the “Repair Date” field.  The user then selects the technician that 

completed the repair from the “Technician” list, which is a list of all users of the application.  

The user can then enter any repair notes, such as what was repaired.  Once all the information 

has been entered, the user can then press the “Save Repair” button or the “Cancel Repair” button.  

If the user presses the “Cancel Repair” button, the repair report is reset and nothing is saved.  If 

the user presses the “Save Repair” button, if all required information has been entered, the repair 



 

25 

report is saved.  If all the required information has not been entered, the user is warned that the 

required information has not been entered and the report is not saved. 

5.3.4 Calibration/Repair History Tab 

  The user can view the history for a customer’s equipment by using the 

“Calibration/Repair History” tab.  As figure 18 shows, the entire list of equipment for the 

customer is listed on the left side of the tab, and the equipment history list is on the right side of 

the tab. 

 

Figure 18: Calibration/Repair History Tab 
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To view the history for a piece of equipment, the user must first select the equipment 

from the equipment list.  When a piece of equipment is selected, the history list changes to 

reflect the history for that piece of equipment.  Any calibration or repair reports that have been 

submitted for the selected equipment will be listed.  The date the equipment was added to the 

customer will always be the first entry, followed by the calibration and repair reports.  To view 

the details about a history item, the user can double click on the item in the history list, or he/she 

can select the item and press the “View” button.  Figure 19 shows how the details for a history 

item are displayed. 

 

Figure 19: View History 
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5.4 File Menu 

From the “File” menu, the user has the option to sign out, print the currently loaded 

customer, view a print preview of the currently loaded customer or exit the application (see 

Figure 20). 

 

Figure 20: File Menu 

5.4.1 Sign Out 

 When the user selects the “Sign Out” option from the “File” menu, if no changes have 

been made to the currently loaded customer, the user is signed out and returned to the login 

screen (see Figure 6).  If changes have been made to the currently loaded customer the user is 
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warned that there have been unsaved changes made and he/she is asked if the changes should be 

saved before signing out (see Figure 21). 

 

Figure 21: Confirm Save 

5.4.2 Print 

 If a customer is loaded in the display, the “Print” option is enabled, otherwise the option 

is disabled (see Figure 20).  When the print option is pressed the Windows print window is 

displayed and the user can select several options, such as the printer to print to, the number of 

copies and the printer settings (see Figure 22). 

 

Figure 22: Print Window 
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 When the user presses the “Cancel” button, the print window is closed, and the user is 

returned to the customer display window.  When the user presses the “Print” button, the currently 

loaded customer’s information is printed.  The information that is printed includes customer 

name, shipping address, mailing address, phone number, notes, contacts list and equipment list. 

5.4.3 Print Preview 

 If a customer is loaded, the “Print Preview” option is enabled in the display, otherwise 

the option is disabled (see Figure 20).  When the “Print Preview” option is pressed, the print 

preview window is loaded.  The same information that would be printed using the printer is 

loaded into this window and the user is able to preview the print before actually printing the 

customer information.  After viewing the print preview, if the user decides he/she wants to print 

the information he/she can press the print button in the top left corner of the print preview 

window, and the information will be printed by the default printer he/she has installed (see 

Figure 23. Page 30). 
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Figure 23: Print Preview 

5.4.4 Exit 

 The “Exit” option from the “File” menu closes the application.  When the user uses this 

selection, the application will close if no changes have been made to the currently loaded 

customer.  If changes have been made to the currently loaded customer, the user is warned that 

there have been unsaved changes made and he/she is asked if they would like to save the changes 

before the application is closed (see Figure 21). 
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5.5 Tools Menu 

 From the “Tools” menu, the user has the options to add a new customer, perform an 

advanced search or view upcoming calibrations (see Figure 24). 

 

Figure 24: Tools Menu 
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5.5.1 Add New Customer 

 The user can add a new customer by using either the “Add New Customer” link on the 

main display or the “Tools” menu and selecting “Add New Customer.”  Once the “Add 

Customer” dialog is displayed, the user can enter the information for that company: company 

name, shipping address, mailing address, phone number, fax and account type (see Figure 25). 

 

Figure 25: Add Customer 

 The user only needs to specify a name for the company, all other information is not 

required in order to add a company to the database.  The account type has three different options: 

“Distributor”, “Rep” and “In-house.”  If “Rep” or “In-house” is selected, the text box to the right 

of the drop down is enabled and the user can enter the technician that is the rep or the person in-

house that is responsible for that account.  Once all the information has been entered the user can 

press the “Cancel” button or the “Save” button.  If the user presses the “Cancel” button the 
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dialog is closed and the company is not added.  If the user presses the “Save” button, the 

company is added to the database. If a company name has not been added, the user is warned that 

a company name is required and the customer is not saved.  If the company name has been 

specified, then the customer is saved in the database and the dialog closes.  Once the dialog is 

closed, the customer that was just added is loaded into the main customer display. This easily 

allows the user to continue to add in more information about the customer. 

5.5.2 Advanced Search 

 The “Advanced Search” dialog allows the user to search for customers by certain criteria 

(see Figure 26. Page 34). 

 

Figure 26: Advanced Search 
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 As Figure X shows, the user can search by multiple criteria for a customer.  The different 

options include the following: 

• Location 
o City 
o State 
o Area code 

• Equipment 
o Measuring principle 
o Exact equipment 

• Calibration date 
o Specific date 
o Date range 

• Account type 
o Unspecified – this will search for any customer that does not have an account type 

specified 
o Distributor 
o Rep 

 Specific employee – when “Rep” is selected, the text box becomes 
enabled and you can enter a specific employee name to search for as the 
rep. 

o In-house 
 Specific employee - when “In-house” is selected the text box becomes 

enabled and you can enter a specific employee name to search for as the 
In-house employee responsible for that account. 

• Contact name 
o First name 
o Last name 

 

5.5.3 Upcoming Calibrations 

 The “Upcoming Calibrations” window is automatically displayed when the user logs in, 

but if he/she would like to view upcoming calibrations after he/she logs in, the option is available 

under the “Tools” menu.  When the user selects the “Upcoming Calibrations” from the “Tools” 

menu, the upcoming calibrations dialog is loaded and the user has the same functionality as 

described in section 5.2. 
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5.6 Administration Menu 

 If the user is an administrator, he/she will be able to access the “Administration” menu.  

From the “Administration” menu, the user can add/edit users or add/edit equipment (see Figure 

27. Page 36). 

 

Figure 27: Administration Menu 

5.6.1 Add/Modify User 

 If the “Add/Modify User” option is chosen from the “Administration” menu, the 

“Add/Modify User” dialog appears centered in the middle of the application (see Figure 28. Page 

37).  While this dialog is opened the user cannot interact with the rest of the application until the 
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dialog is closed.  In the “Add/Modify Users” dialog, the left side of the dialog lists all the users 

of the system, displayed in two groups: Administrators and Users.  From here the user can add 

another user or modify an existing user. 

  

 

 

Figure 28: Add/Modify Users 

5.6.1.1 Add User 

If the user would like to add another user to the system, he/she would need to select the 

“Add User” tab, if not already selected, and proceed to fill in the information for that user.  To 

add a new user the first name, last name, login, password and confirm password need to be filled 
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in and the account type must be selected.  The email and phone number are not required for 

adding a new user.  Once the information has been entered, the user can press either the “Add 

User” button or the “Clear” button.  The “Add User” button will attempt to add the user to the 

system. The “Clear” button will reset the form.  If the login entered is unique, and the passwords 

match, the user will be added to the system and to the user list on the left side of the dialog.  If 

the login is not unique or the passwords do not match, then the user will be warned that the login 

is not unique or that the passwords do not match and the new user will not be added to the 

system. 

5.6.1.2 Modify User 

To edit an existing user, the user must either select the user from the list and press the 

“Edit User” button or double click the user in the list.  This loads the user’s information into the 

“Modify User” tab and the user can then be edited (see Figure 29). 



 

38 

 

Figure 29: Modify User 

 Everything about an existing user can be edited, except the login.  The user is able to 

disable an account (which prevents the user from being able to log in), change the first name, last 

name, account type, email, phone and even the password.  The “Delete” button is also available 

(enabled) if the user has not submitted any reports or been the technician for any reports that 

have been submitted.  If the user has submitted a report or been the technician in a submitted 

report, then the account cannot be deleted and the “Delete” button is disabled.  Once the 

information has been changed the user can press the “Submit Changes” button or the “Cancel 

Changes” button.  If the user presses the “Cancel Changes” button, all changes will be reset to 

the loaded user’s original information.  If the user presses the “Submit Changes” button, the 
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changes will be saved as long as all of the required information is provided: first name, last 

name, account type and matching passwords. 

5.6.2 Add/Modify Equipment 

 If the user would like to add or modify the equipment available to add to customers, 

he/she would select the “Add/Modify Equipment” from the “Administration” menu.  Like the 

“Add/Modify User” dialog, the “Add/Modify Equipment” dialog will be centered in the middle 

of the application window (see Figure 30. Page 40). 

 

Figure 30: Add/Modify Equipment 

 The setup of the “Add/Modify Equipment” dialog is very similar to the “Add/Modify 

Users” dialog.  On the left side is the list of all of the equipment, separated by type.  There are 

five types of equipment: x-rays, bench equipment, portable equipment, standards and other 
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equipment.  All existing equipment is loaded into the list, under its appropriate section, when the 

dialog is opened.  On the right side of the dialog is where the user can add new equipment or 

modify existing equipment from either the “Add Equipment” tab or the “Modify Equipment” tab. 

5.6.2.1 Add Equipment 

 If the user would like to add new equipment he/she would need to select the “Add 

Equipment” tab, if it is not already selected.  From this tab the user needs to first select the 

equipment type for the equipment that is to be added (see Figure 31. Page 41). 

 

Figure 31: Add Equipment 

 Once the equipment type has been selected from the drop down list, the user can enter in 

the information for that equipment.  All fields are required when adding equipment, if anything 

is not filled in when attempting to add the equipment, the user is notified that something is 
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missing.  The measuring principle is a drop down menu that lists all possible measuring 

principles for a piece of equipment.  If the equipment is an x-ray, the measuring principle drop 

down list is disabled, because the measuring principle is always x-ray. If the equipment is any of 

the other type, the user must select the correct measuring principle from the drop down list 

before pressing the “Add Equipment” button.  Once information has been entered, the user has 

the option to press the “Add Equipment” button or the “Cancel Add” button.  If the user presses 

the “Cancel Add” button, the form is reset.  If the user presses “Add Equipment” the equipment 

will be added if all of the required fields have been filled out; if the fields have not been filled 

out, the user is warned that not all required fields have been filled out and the equipment is not 

added to the system. 

5.6.2.2 Modify Equipment 

 If the user would like to edit existing equipment he/she can either double click the 

equipment in the equipment list or select the equipment and press the “Edit Equipment” button.  

Once either of these is completed, the equipment is loaded into the “Modify Equipment” tab and 

the user can then edit the equipment (see Figure 32. Page 42). 
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Figure 32: Modify Equipment 

 All information about a piece of equipment can be modified, except the measuring 

principle for x-rays which will always be saved as x-ray.  The equipment type text box can only 

be edited if the equipment is of type “other.” This allows the user to add in miscellaneous 

equipment that does not fit any of the main categories.  The “Delete” button works similarly to 

how the delete button works in “Add/Modify Users.”  If the equipment has not been added to any 

companies, then the “Delete” button is enabled and the equipment can be deleted, if the 

equipment has been added to any company, the “Delete” button is disabled.  Once the 

information has been changed, the user can press the “Submit Changes” button or the “Cancel 

Changes” button.  If the “Cancel Changes” button is pressed, the form is reset.  If the “Submit 

Changes” button is pressed the equipment is added to the system if all of the required fields have 
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been filled in.  If all required fields have not been filled in, then the user is warned that there is 

missing information and the equipment is not added. 

6. Testing 

 This application has been tested throughout development as changes are made.  As each 

module has been completed, it has been tested thoroughly to ensure no errors are generated and 

the information is inserted/updated/removed properly.  As modules are completed, they have 

been tested to make sure they work in conjunction with related modules.  Throughout the 

development, as enough modules have been completed for the users to test, users have tested the 

modules for errors and ensured the application meets the company’s expectations. After the 

application was completed, several users were asked to test the application to ensure that with 

normal, everyday use, all of the modules work properly together and the information is stored 

and displayed correctly.  All user feedback has been taken into account and appropriate changes 

have been made. 

7. Conclusion 

 The UPA Technology Customer and Service Tracking (CAST) database application is 

the solution to the problems that UPA Technology has faced with current and previous database 

applications it has tried to use.  CAST has met all of the deliverables originally stated and also 

has the ability to print, which was not in the original deliverables.  CAST has been thoroughly 

tested throughout development by the future users of the application.  All reported bugs were 

fixed, and user feedback has been incorporated.  The simple interface and extra features will 

allow the users to operate more effectively and efficiently while allowing for further expansion 

of the application if additional features are required. 


